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Chapter 1

Introduction

The DE10-Lite presents a robust hardware design platform built around the Altera MAX 10 FPGA.
The MAX 10 FPGA is well equipped to provide cost effective, single-chip solutions in control
plane or data path applications and industry-leading programmable logic for ultimate design
flexibility. With MAX 10 FPGA, you can get lower power consumption / cost and higher
performance. When you need high-volume applications, including protocol bridging, motor control
drive, analog to digital conversion, image processing, and handheld devices, the MAX 10 Lite
FPGA is your best choice.

The DE10-Lite development board includes hardware such as on-board USB Blaster, 3-axis
accelerometer, video capabilities and much more. By leveraging all of these capabilities, the
DE10-Lite is the perfect solution for showcasing, evaluating, and prototyping the true potential of
the Altera MAX 10 FPGA.

The DE10-Lite contains all components needed to use the board in conjunction with a computer
that runs the Win 7/Win 10 64-bit version or later.

1.1 Package Contents

Figure 1-1 shows a photograph of the DE10-L.ite package.

% wis @ The DE10-Lite board
(B8RS ,!!1 l @ Type AMale to Type B Male USB Cable

W | Tl [ e | 20 | Rt foi |

Figure 1-1 The DE10-Lite package contents
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The DE10-L.ite package includes:

e The DE10-Lite board
e Type A Male to Type B Male USB Cable

1. 2 DE10-Lite System CD

The DE10-Lite System CD contains the documentation and supporting materials, including the
User Manual, Control Panel, System Builder, reference designs and device datasheets.

User can download this System CD from the web (http://DE10-L.ite.terasic.com/cd).

1. 3 Layout and Components

This section presents the features and design characteristics of the board.

A photograph of the board is shown in Figure 1-2 and Figure 1-3. It depicts the layout of the board
and indicates the location of the connectors and key components.

2x20 Altera MAX 10
GPIO 10M50DAF484C7G

4-bit Resistor VCGA

Accelerometer

Arduino
Connector
5V Power :
USB-Blaster —
64MB SDRAM
Button x2
SV/CND  Ieifupd =St S ~ W t<r (LI I
2-Pin Header L
R 1 £ ' '. 3 1 K 1 [ g (e ‘: fi:] ".': LED x10
7-Segment o | hwll ll l i I. | I| ;
Display x6 | ""7 : - v | !n!l 411 l ! ! !n ’u Switch x10
Figure 1-2 Development Board (top view)
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Figure 1-3 Development Board (bottom view)

This board has many features that allow users to implement a wide range of designed circuits, from
simple circuits to various multimedia projects.

The following hardware are provided on the board:

FPGA Device

e MAX 10 10M50DAF484C7G Device

e Integrated dual ADCs, each ADC supports 1 dedicated analog input and 8 dual function pins
e 50K programmable logic elements

e 1,638 Kbits MOK Memory

e 5,888 Kbits user flash memory

e 14418 %18 Multiplier

e 4PLLs

Programming and Configuration

e On-Board USB Blaster (Normal type B USB connector)
Memory Device

e 64MB SDRAM, x16 bits data bus
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Connectors

e 2x20 GPIO Header
e Arduino Uno R3 Connector, including six ADC channels.

Display

e 4-bit resistor-network DAC for VGA (With 15-pin high-density D-sub connector)
Switches, Buttons and LEDs

10 LEDs

10 Slide Switches

2 Push Buttons with Debounced.
Six 7-Segments

Power

e 5V DC input from USB or external power connector.

1. 4 Block Diagram of the Board

Figure 1-4 gives the block diagram of the board. To provide maximum flexibility for the user, all
connections are made through the MAX 10 FPGA device. Thus, the user can configure the FPGA to
implement any system design.

FPGA

i | Clock

USB Blaster
MAX ’a —x39 5 A i
SDRAM64MB (16bits)

R
10M50DAF484 e

Arduino Header nalog x14_, —u

VGA (4 bit)

pEMIN ccoocccoucc 0000000
Debounced g ccccccccuccocccocooo
GPIO

x48 x10 “x10 X2
‘5" L-" E" B J E} PUE:BUE\JXZ
7-Segment Display x6
YYVVIVIVVYVVVIVY 4 4
REERSERERFEIT R LT

Slide Switch x10

Figure 1-4 Board Block Diagram

6 www.terasic.com
June 5, 2020

DE10-Lite
aslc User Manual

www.terasic.com


http://www.terasic.com/
http://www.terasic.com/
http://www.terasic.com/

1. 5 Getting Help

Here are the addresses where you can get help if you encounter any problem:

e Terasic Inc.

9F., No0.176, Sec.2, Gongdao 5th Rd, East Dist, Hsinchu City, 30070. Taiwan

Email: support@terasic.com

Tel.: +886-3-5750-880

Web: http://DE10-Lite.terasic.com
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Chapter 2

Control Panel

The DE10-Lite board comes with a Control Panel program that allows users to access various
components on the board from a host computer. The host computer communicates with the board
through a USB connection. The program can be used to verify the functionality of components on
the board or be used as a debug tool while developing any RTL code.

This chapter first presents some basic functions of the Control Panel, then describes its structure in
the block diagram form, and finally describes its capabilities.

2.1 Control Panel Setup

The Control Panel Software Utility is located in the directory “Tools/ControlPanel” in the
DE10-Lite System CD. It's free of installation, just copy the whole folder to your host computer
and launch the control panel by executing the “DE10_Lite ControlPanel.exe”.

Specific control circuits should be downloaded to your FPGA board before the control panel can
request it to perform required tasks. The program will call Quartus Prime tools to download the
control circuit to the FPGA board through the USB-Blaster [USB-0] connection.

To activate the Control Panel, perform the following steps:

1. Make sure Quartus Prime 16.0 or a later version is installed successfully on your PC.

2. Connect the USB cable provided to the USB Blaster port.

3. Download bin32 folder from link http://mail.terasic.com.cn/~wyzhou/bin32.zip , unzip and

copy the bin32 folder to the <Path to Quartus Prime installation>\quartus folder (for example:
C:\intelFPGA\16.0\quartus).

Note: DE10_Lite_ControlPanel is created to support working with 32bit OS. However, it does not s
upport the 32bit OS in the Quartus Prime 15.1 or later.

4. Start the executable DE10_Lite ControlPanel.exe on the host computer. The Control Panel user
interface shown in Figure 2-1 will appear.
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5. The DE10_Lite _ControlPanel.sof bit stream is loaded automatically as soon as the
DE10_Lite_ControlPanel.exe is launched.

6. In case of a disconnection, click on CONNECT where the .sof will be re-loaded onto the board.

Please note that the Control Panel will occupy the USB port until you close that port; yo
u cannot use Quartus Il to download a configuration file into the FPGA until the USB po
rt is closed.

7. The Control Panel is now ready to use; experience it by setting the ON/OFF status for some
LEDs and observing the result on the DE10-L.ite board.

AT

TERTI S | Sy

Figure 2-1 The DE10-Lite Control Panel

The concept of the DE10-Lite Control Panel is illustrated in Figure 2-2. The “Control Circuit” that
performs the control functions is implemented in the FPGA board. It communicates with the
Control Panel window, which is active on the host computer, via the USB Blaster link. The
graphical interface is used to send commands to the control circuit. It handles all the requests and
performs data transfers between the computer and the DE10-L.ite board.
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7-SEG Display

— VGA

USB Blaster Control
Circuit

Button/
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' B _

Figure 2-2 The DE10-Lite Control Panel concept

The DE10-Lite Control Panel can be used to light up LEDs, change the values displayed on the
7-segment, monitor buttons/switches status, read/write the SDRAM Memory, output VGA color
pattern to VGA monitor. The feature of reading/writing a word or an entire file from/to the Memory
allows the user to develop multimedia applications without worrying about how to build a Memory
Programmer.

2. 2 Controlling the LEDs, 7-segment Displays

A simple function the Control Panel is capable of is the modification of settings for the 7-segement
LED displays.

Choosing the LED tab leads you to the window in Figure 2-3. Here, you can directly turn the LEDs
on or off individually or by clicking “Light All” or “Unlight All”.
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Figure 2-3 Controlling LEDs

Choosing the 7-SEG tab leads you to the window shown in Figure 2-4. From the window, directly
use the left-right arrows to control the 7-SEG patterns on the DE10-Lite board which are updated
immediately. Note that the dots of the 7-SEGs are not enabled on the DE10-L.ite board.

A 'l l\ I ‘

unnnhn»u;

Y ’

7-SEG | Accelerometer
Switches ‘ | VGA |
L A | mm o e e ey e

>

Figure 2-4 Controlling 7-SEG display
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The ability to set arbitrary values into simple display devices is not needed in typical design
activities. However, it gives users a simple mechanism for verifying that these devices are
functioning correctly in case a malfunction is suspected. Thus, it can be used for troubleshooting
purposes.

2. 3 Switches and Push-buttons

Choosing the Switches tab leads you to the window in Figure 2-5. The function is designed to
monitor the status of slide switches and push buttons in real time and show the status in a graphical
user interface. It can be used to verify the functionality of the slide switches and push-buttons.

‘ Accelerometer

DDUUUUUUUU

SW9 SW8 SW7 SW6 SWS5 SW4 SW3 SW2 SW1 SWO0
M Honitor Switches and Pushbuttons

Figure 2-5 Monitoring switches and buttons

The ability to check the status of push-button and slide switch is not needed in typical design
activities. However, it provides users a simple mechanism to verify if the buttons and switches are
functioning correctly. Thus, it can be used for troubleshooting purposes.

2.4 SDRAM Controller and Programmer

The Control Panel can be used to write/read data to/from the SDRAM chips on the DE10-L.ite board.
As shown below, we will describe how the SDRAM may be accessed; Click on the Memory tab and
select “SDRAM?” to reach the window in Figure 2-6.
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Figure 2-6 Accessing the SDRAM

A 8-bit word can be written into the SDRAM by entering the address of the desired location,
specifying the data to be written, and pressing the Write button. Contents of the location can be read
by pressing the Read button. Figure 2-6 depicts the result of writing the hexadecimal value AB
into hexadecimal offset address C00, followed by reading the same location.

The Sequential Write function of the Control Panel is used to write the contents of a file into the
SDRAM as follows:
1. Specify the hexadecimal starting address in the Address box.

2. Specify the hexadecimal number of bytes to be written in the Length box. If the ent
ire file is to be loaded, then a checkmark may be placed in the File Length box instead
of giving the number of bytes.

3. To initiate the writing process, click on the Write a File to Memory button.

4. When the Control Panel responds with the standard Windows dialog box asking for t
he source file, specify the desired file location in the usual manner.

The Control Panel also supports loading files with a .hex extension. Files with a .hex extension are
ASCII text files that specify memory values using ASCII characters to represent hexadecimal
values. For example, a file containing the line

0123456789ABCDEF
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defines eight 8-bit values: 01, 23, 45, 67, 89, AB, CD, EF. These values will be loaded
consecutively into the memory.

The Sequential Read function is used to read the contents of the SDRAM and fill them into a file as
follows:

1. Specify the hexadecimal starting address in the Address box.

2. Specify the hexadecimal number of bytes to be copied into the file in the Length bo
x. If the entire contents of the SDRAM are to be copied (which involves all 64 Mbytes),
then place a checkmark in the Entire Memory box.

3. Press Load Memory Content to a File button.

4. When the Control Panel responds with the standard Windows dialog box asking for t
he destination file, specify the desired file in the usual manner.

2.5 Accelerometer

The G-Sensor in the accelerometer utilizes a spirit level to function. The user can rotate the
DE10-LIte board different directions, up or down, left or right. The bubble will travel quickly travel
in respect to the user’s movements. Meanwhile, the control panel will show the accelerated data in
X-axis, y-axis and z-axis as shown in Figure 2-7. Note that the resolution measurement of 3-axises
accelerometer is set to +/- 2g.

T
LT B [} :'l 'I} ‘b? !! II‘ ‘

——
LED | Memory ’
(

e
7-SEG | Accelerometer
| S — -

e

Figure 2-7 Level by G-Sensor
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2.6 VGA

DE10-Lite Control Panel provides VGA pattern function that allows users to output color pattern to
LCD/CRT monitor using the DE10-L.ite board. Follow the steps below to generate the VGA pattern
function:

Choosing the VGA tab leads you to the window in Figure 2-8.

Plug a D-sub cable to the VGA connector of the DE10-Lite board and LCD /CRT monitor.

The LCD/CRT monitor will display the same color pattern on the control panel window.

Click the drop down menu shown in Figure 2-8 where you can output the selected pattern
individually.

LED

|

| Memory ’

7-SEG j | Accelerometer

—) \.

Figure 2-8 Controlling VGA display under Control Panel
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2. 7 Overall Structure of the DE10-Lite Control Panel

The DE10-Lite Control Panel is based on a Nios Il Qsys system instantiated in the MAX 10 FPGA
with software running on the on-chip memory. The software was implemented in coding Language
C; and the hardware was implemented in Verilog HDL code with Qsys builder. The source code is
not available on the DE10-L.ite System CD.

To run the Control Panel, users should follow the configuration setting according to Section 3.1.
Figure 2-9 depicts the structure of the Control Panel. Each input/output device is controlled by the
Nios Il Processor instantiated in the FPGA chip. The communication with the PC is done via the
USB Blaster link. The Nios Il interprets the commands sent from the PC and performs the
corresponding actions.

FPGA/QSYS

VGA

EEE

%3
b3
& 8 7-SEG Display
3
JTAG F1
Blaster > T, ~
Hardware d S
3
‘ 8 U L ED/Button/
| > GRS Switch
i
7 On-Chip =3
> SDRAM
Nios Il
Program

Figure 2-9 The block diagram of the DE10-Lite control panel
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Chapter 3
Using the Starter Kit

This chapter provides instructions to use the board and describes the peripherals.

3.1 Configuration of MAX 10 FPGA on DE10-Lite

There are two types of configuration method supported by DE10-Lite:
1. JTAG configuration: configuration using JTAG ports.

JTAG configuration scheme allows you to directly configure the device core through JTAG pins -
TDI, TDO, TMS, and TCK pins. The Quartus Il software automatically generates .sof files that are
used for JTAG configuration with a download cable in the Quartus Il software program.

2. Internal configuration: configuration using internal flash.

Before internal configuration, you need to program the configuration data into the configuration
flash memory (CFM) which provides non-volatile storage for the bit stream. The information is
retained within CFM even if the DE10-Lite board is turned off. When the board is powered on, the
configuration data in the CFM is automatically loaded into the MAX 10 FPGA.

B JTAG Chain on DE10-Lite Board

The FPGA device can be configured through JTAG interface on DE10-Lite board, but the JTAG
chain must form a closed loop, which allows Quartus Il programmer to the detect FPGA device.
Figure 3-1 illustrates the JTAG chain on DE10-L.ite board

USB Blaster Circuit

Quartus Il
&4 Programmer MAX Il JTAG UART X Alm b,
e EPM 240 JTAG Config Signals | VAN 10

QUARTUS"II

7

v

Figure 3-1 The JTAG configuration scheme
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B Configure the FPGA in JTAG Mode

The following shows how the FPGA is programmed in JTAG mode step by step.

1. Open the Quartus Il programmer, please Choose Tools > Programmer. The Programmer
window opens. See Figure 3-2.

-
& Programmer - Dy/systern_cd/Demonstrations/Default/DE10_LITE_Default - DE10_LITE_Default - [DE10_LITE Default.c . ([=]sl=l i3
File Edit \iew Processing Tools Window Help

Search altera.com .

;Hardware&'.etup... USB-Blaster [USB-0] Mode: [.JTAG hi Progress: ]

|:| Enable real-time ISP to allow background pregramming when available

File: Device Checksum Usercode Program/ Verify Blank- Examine

pl start Configure Check

wl Stop

¥ Delste < | i 3

M Add File... ke
e Change File...
Bl save File
r* Add Device...
1'h up

1% Dowen

m

Figure 3-2 Programmer Window

2.  Click “Hardware Setup”, as circled in Figure 3-2.
3. Ifitis not already turned on, turn on the USB-Blaster [USB-0] option under currently selected
hardware and click “Close” to close the window. See Figure 3-3.
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ey T )

Hardware Settings | JTAG Settings |

Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.

Currently selected hardware: || USB-Blaster [USB-0] -

Available hardware items

Hardware Server Port | Add Hardware... I

ISB-Blaster Local USB-0

|F‘.em|:|'.fe Hard'-.'.'ar&|

Figure 3-3 Hardware Setting

4.  Click “Auto Detect” to detect all the devices on the JTAG chain, as circled in Figure 3-4.

r& Programmer - D:/syste aultc. LE —r. S I

File Edit \iew Processing Toolz Window Help Search altera.com .

;Hardwares'etup... U5B-Blaster [USB-0] Mode: |JTAG - Progress: ]

Enable real-time ISP to allow background programming when available

%7 File Device Checksum Usercode Program/ Verify Blank- Examine
Pl Start Configure Check
wlh stop
M Auto Detect

| X Delste | 4| m r

P Add File...

r* Add Device...
e
( bpown

m

Figure 3-4 Detect FPGA device in JTAG mode
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5.  Select detected device associated with the board, as circled in Figure 3-5.

Found devices with shared JTAG ID for device 1. Please select your device.

@ 10MS0DA

) 10MS0DAES

) 10M50DC

Figure 3-5 Select 10M50DA device

6. FPGA s detected, as shown in Figure 3-6.

o

]
4% Programmer - D:/syste fault.c... LE p—. e I
File Edit View Processing Tools Window Help Search atera.com .
'?n Hardware Setup...| USB-Blaster [USB-0] Mode: |JTAG - Progress: ]

Enable realtime ISP to allow background programming when available
%— File Device Checksum Usercode Program/ Werify Blank- Examine
L Start Configure Check
<nene= L O

"~ ahisp | | [one 10M50DA 00000000
M Auto Detect

| 3 Delete | < i

P Add File...

| L] Change File...
ﬂl Save File
F* Add Device...
U
\L/ 10MS0DA
1 Down , TDo
o

m

Figure 3-6 FPGA detected in Quartus Il programmer
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7. Right click on the FPGA device and click “Change File” to open the .sof file to be
programmed, as highlighted in Figure 3-7.

g S
A) Programmer - D/system_cd/Demonstrations/Default/DE10_LITE Default - DEL0_LITE Default - [DEL0_LITE_Default.c... (o)

File Edit V\iew Processing Tools Window Help Search attera.com .

£ Hardware Setup...| USB-Blaster [USB-0] Mode: [JTAG +|  Progress: ]

Enable reaktime ISP to allow background programming when available

%7 File Device Checksum Usercode Program/ Werify Blank- Examine
i Start Configure Check
T Sbowmn | Stop “none= 10MS0DA | 00000000 =nonex

¥ Delete Del

B Auto Detect Select Al Ciri+A
¥ Delete < |

P AddFile...
I Add File... % Change File
Save Fil
J= Change Fike.. e e
Add IPS File...

@l Save File

r* Add Device...

Change IPS File...
Delete IPS File

p— e 1 1
u
\L/ 10M5004 Add EKP File...
l,% Down 4 0O Change EKP File...

Delete EKP File

Replaces a =elected programming file

Add PR Programming File...

Figure 3-7 Open the .sof file to be programmed into the FPGA device

8.  Select the .sof file to be programmed, as shown in Figure 3-8.

-
4% Select Mew Programming Fil "E
Look in: [ . Dieystem_cd\Demonstrations\Default v] Q O G |_|J E]

A My Computer Name = Size Type  Date Modified
: Admiristat )i db Fil..der 2016/6(16 £2F 11:26:40
R, Administrator |\ greybox_tmp Fil.der 20160616 £2F 11:26:27
v Fil...der 2018/6M6 £ 11:2627
JJ VGA_DATA Fil..der 20166M6 L F 11:26:27
|| DE10_LITE_Default.pof 14MB pofFie 20168815 T 06:48:30
DE10_LITE_Default.sof 34MB sofFile 2016615 T2 06:48:31 |
File name: DE10_LME_Default.zof QOpen
Files of type: | Programming Files (*.sof *.pof *jam * jbc *.ekp *.jic) v|| cancel |

Figure 3-8 Select the .sof file to be programmed into the FPGA device
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9. Click “Program/Configure” check box and then click “Start” button to download the .sof file

into the FPGA device, as shown in Figure 3-9.

& Programmer - D;v’system_cd{Demor‘lstrﬂﬁons,‘Defauh;fDElD_LlTE_ﬁﬂuE - DEla_n I !_MuE - |Bm_ﬂ'!_[)efﬂu|tc_ @ﬂum
— e

| File | Edit Wiew Processing Tools Window Help Search

altera.com .

2, Hardware Setup..| USB-Blaster [USB-0] Mode: |ITAG ~|  Progress: ’

)

|:| Enable real-time ISP to allow background programming when available

N File Device Checksum Usercode Program/ Verify
il Start Configure

ol stop DE10_LIME_Default.sof 10MS0DAF4E4 003EASFS DO3EASFS

X Delste 4| T

Blank- Examine
Check

P Add File...

P change File...

Bl save File

r* Add Device. .

T up 10MS0DAF484
l.% Down DO

m

Figure 3-9 Program .sof file into the FPGA device

B Internal Configuration

e The configuration data to be written to CFM will be part of the programmer object file
(.pof). This configuration data is automatically loaded from the CFM into the MAX 10

devices when the board is powered up.

e Please refer to Chapter 8: Programming the Configuration Flash Memory (CFM) for the

basic programming instruction on the configuration flash memory (CFM).

MAX 10 Device

CRAM

Internal

JTAG Configuration

In-System
Programming

CFM

Figure 3-10 High-Level Overview of Internal Configuration for MAX 10 Devices
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B Status LED

The DE10-Lite development board includes board-specific status LEDs to indicate board status.
Please refer to Table 3-1 for the description of the LED indicator. Please refer to Figure 3-11 for
detailed LED location.

D1 D2

@0 O ()

OOOOO“

UNIVERSITY
PROGRA NF

‘ssannes
91102

O@
i [ [ g e ﬁﬁw‘-‘-i ﬁl

w w

Swi
'ﬁ »1||' ||¢ w|| “ !h !L llt Ill

‘n slil |

Figure 3-11 Status LED position

Table 3-1 Status LED

ULED llluminates when the on-board USB-Blaster is working
D2 CONF_DONE llluminates when the FPGA is successfully configured.
D3 5V llluminates when Input power is active. Not Installed.
D4 Power Good llluminates when board power system is OK.
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3. 2 Clock Circuitry

Figure 3-12 shows the default frequency of all external clocks to the MAX 10 FPGA. A clock
generator is used to distribute clock signals with low jitter. The two 50MHz clock signals connected
to the FPGA are used as clock sources for user logic. One 24MHz clock signal is connected to the
clock inputs of USB microcontroller of USB Blaster. One 10MHz clock signal is connected to the
PLL1 and PLL3 of FPGA, the outputs of these two PLLs can drive ADC clock. The associated pin
assignment for clock inputs to FPGA I/O pins is listed in Table 3-2.

Warning !!
Do not modify the clock generator settings.

Incorrect setting will cause the system to not work.

\
|

USB Blaster ¢

=

" Clock Generator =
24MHz —>  CDCE937 A onYA
(fixed-frequency) ®
UBT_CLK_24 ®
Vi ——— MAX
ADC_CLK_10 10
Ve » N5
MAX10_CLK1 50
Y4 > Pl1
MAX10_CLK2_50
NS » N14

Figure 3-12 Clock circuit of the FPGA Board

Table 3-2 Pin Assignment of Clock Inputs

ADC_CLK_10 PIN_N5 10 MHz clock input for ADC (Bank 3B) 3.3-V LVTTL

MAX10_CLK1 50 |PIN_P11 50 MHz clock input(Bank 3B) 3.3-V LVTTL

MAX10_CLK2 50 | PIN_N14 50 MHz clock input(Bank 3B) 3.3-V LVTTL
DE10-Lite 24 www.terasic.com

aslc User Manual June 5, 2020

www.terasic.com


http://www.terasic.com/
http://www.terasic.com/
http://www.terasic.com/

3. 3 Using the Push-buttons, Switches and LEDs

B User-Defined Push-buttons

The board includes two user defined push-buttons that allow users to interact with the MAX 10
FPGA device. Each of these switches is debounced using a Schmitt Trigger circuit as indicated in
Figure 3-13. A Schmitt trigger feature introduces hysteresis to the input signal for improved noise
immunity, especially for signal with slow edge rate and act as switch debounce in Figure 3-14 for
the push-buttons connected. Table 3-3 list the pin assignment of user push-buttons.

VCC3P3

KEYO '
_O ‘
—» B8 ‘

KEY1 74AUC17 AETEE{A .

. N e
| . .. MAX10
£ L L

Figure 3-13 Connections between the push-button and MAX 10 FPGA

lPushbutton depressed lPushbutton released

Before

Debouncing ||||||||| |||||||

Schmitt Trigger
Debounced

&
<

v

Figure 3-14 Switch debouncing

Table 3-3 Pin Assignment of Push-buttons

Signal Name FPGA Pin No. I/O Standard ‘

KEYO PIN_B8 Push-button[0] 3.3V SCHMITT TRIGGER"
KEY1 PIN_A7 Push-button[1] 3.3V SCHMITT TRIGGER"
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B User-Defined Slide Switch

There are ten slide switches connected to FPGA on the board (See Figure 3-15). These switches are
used as level-sensitive data inputs to a circuit. Each switch is connected directly and individually to
a pin on the MAX 10 FPGA. When the switch is in the DOWN position (closest to the edge of the
board), it provides a low logic level to the FPGA, and when the switch is in the UP position it
provides a high logic level. Table 3-4 list the pin assignments of the user switches.

ABTERAY
MAX 10

FIS B14 A14 A13 Bl2 A12 012 D12 Cll CIU Logic™1"

PARRRRRRAY B

SW9 SW8 SW7 SW6 SW5 Sw4 SW3 SW2 SW1 SWO0 Logic™0"

Figure 3-15 Connections between the slide switches and MAX 10 FPGA

Table 3-4 Pin Assignment of Slide Switches

Signal Name FPGA Pin No. | Description I/O Standard ‘

SWO PIN_C10 Slide Switch[0] 3.3-V LVTTL
swi PIN_C11 Slide Switch[1] 3.3-V LVTTL
SW2 PIN_D12 Slide Switch[2] 3.3-V LVTTL
Sw3 PIN_C12 Slide Switch[3] 3.3-V LVTTL
SW4 PIN_A12 Slide Switch[4] 3.3-V LVTTL
SW5 PIN_B12 Slide Switch[5] 3.3-V LVTTL
SW6 PIN_A13 Slide Switch[6] 3.3-V LVTTL
SW7 PIN_A14 Slide Switch[7] 3.3-V LVTTL
Sws PIN_B14 Slide Switch[8] 3.3-V LVTTL
SW9 PIN_F15 Slide Switch[9] 3.3-V LVTTL
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B User-Defined LEDs

There are also ten user-controllable LEDs connected to FPGA on the board. Each LED is driven
directly and individually by a pin on the MAX 10 FPGA,; driving its associated pin to a high logic
level turns the LED on, and driving the pin low turns it off. Figure 3-16 shows the connections
between LEDs and MAX 10 FPGA. Table 3-5 list the pin assignment of user LEDs.

B -LEDRQ A A\ LEDROp 77

A9 LEDR1 A A LEDR1DIZ!Z[

A10 LEDR2 . A LEDRZD 77
LEDR3 LEDR3.\ 7\7\

=5 Bl0 —=—S AN
ZA!D onYa _ D13 ~LEDR4 A A LEDR4y, LEDR4,,
. c13 LEDR5 \ A LEDRS5, Izz
MAX 10

14| ~LEDRE A A LEDRE), LEDRG LEDRG6

D14 LEDR7 A A LEDR?D 7\7\
All LEDR8 . A LEDRBD 77

B11 LEDR9 . A LEDRQD IZEZ[

Figure 3-16 Connections between the LEDs and MAX 10 FPGA

Table 3-5 Pin Assignment of LEDs

Signal Name FPGA Pin No. | Description I/O Standard ‘

LEDRO PIN_A8 LED [0] 3.3-V LVTTL
LEDR1 PIN_A9 LED [1] 3.3-V LVTTL
LEDR2 PIN_A10 LED [2] 3.3-V LVTTL
LEDR3 PIN_B10 LED [3] 3.3-V LVTTL
LEDR4 PIN_D13 LED [4] 3.3-V LVTTL
LEDR5 PIN_C13 LED [5] 3.3-V LVTTL
LEDR6 PIN_E14 LED [6] 3.3-V LVTTL
LEDR7 PIN_D14 LED [7] 3.3-V LVTTL
LEDRS PIN_A11 LED [8] 3.3-V LVTTL
LEDR9 PIN_B11 LED [9] 3.3-V LVTTL
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3.4 Using the 7-segment Displays

The DE10-Lite board has six 7-segment displays to display numbers. Figure 3-17 shows the
connection of seven segments (common anode) to pins on MAX 10 FPGA. The segment can be
turned on or off by applying a low logic level or high logic level from the FPGA, respectively.

Each segment in a display is indexed from O to 6 and DP (decimal point), with corresponding
positions given in Figure 3-17. Table 3-6 shows the pin assi zgnment of FPGA to the 7-segment

displays.

\ A HEXO0[2]

\ o HEX0[0]

HEXO[1]

HEXO0[3]
Wy

HEXO[4]

HEXO[5]

HEXO0[6]
VWV

HEXO[7]

SRYA\.

MAX 10

Figure 3-17 Connections between the 7-segment display HEX0 and the MAX 10 FPGA

Table 3-6 Pin Assignment of 7-segment Displays

[asic]
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User Manual

HEXO00 PIN_C14 Seven Segment Digit 0[0] 3.3-V LVTTL
HEXO01 PIN_E15 Seven Segment Digit O[1] 3.3-V LVTTL
HEX02 PIN_C15 Seven Segment Digit 0[2] 3.3-V LVTTL
HEXO03 PIN_C16 Seven Segment Digit O[3] 3.3-V LVTTL
HEX04 PIN_E16 Seven Segment Digit O[4] 3.3-V LVTTL
HEX05 PIN_D17 Seven Segment Digit 0[5] 3.3-V LVTTL
HEX06 PIN_C17 Seven Segment Digit 0[6] 3.3-V LVTTL
HEXO07 PIN_D15 Seven Segment Digit 0[7], DP 3.3-V LVTTL
HEX10 PIN_C18 Seven Segment Digit 1[0] 3.3-V LVTTL
HEX11 PIN_D18 Seven Segment Digit 1[1] 3.3-V LVTTL
HEX12 PIN_E18 Seven Segment Digit 1[2] 3.3-V LVTTL
HEX13 PIN_B16 Seven Segment Digit 1[3] 3.3-V LVTTL
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HEX14 PIN_A17 Seven Segment Digit 1[4] 3.3-V LVTTL
HEX15 PIN_A18 Seven Segment Digit 1[5] 3.3-V LVTTL
HEX16 PIN_B17 Seven Segment Digit 1[6] 3.3-V LVTTL
HEX17 PIN_A16 Seven Segment Digit 1[7] , 3.3-V LVTTL
HEX20 PIN_B20 Seven Segment Digit 2[0] 3.3-V LVTTL
HEX21 PIN_AZ20 Seven Segment Digit 2[1] 3.3-V LVTTL
HEX22 PIN_B19 Seven Segment Digit 2[2] 3.3-V LVTTL
HEX23 PIN_A21 Seven Segment Digit 2[3] 3.3-V LVTTL
HEX24 PIN_B21 Seven Segment Digit 2[4] 3.3-V LVTTL
HEX25 PIN_C22 Seven Segment Digit 2[5] 3.3-V LVTTL
HEX26 PIN_B22 Seven Segment Digit 2[6] 3.3-V LVTTL
HEX27 PIN_A19 Seven Segment Digit 2[7] , 3.3-V LVTTL
HEX30 PIN_F21 Seven Segment Digit 3[0] 3.3-V LVTTL
HEX31 PIN_E22 Seven Segment Digit 3[1] 3.3-V LVTTL
HEX32 PIN_E21 Seven Segment Digit 3[2] 3.3-V LVTTL
HEX33 PIN_C19 Seven Segment Digit 3[3] 3.3-V LVTTL
HEX34 PIN_C20 Seven Segment Digit 3[4] 3.3-V LVTTL
HEX35 PIN_D19 Seven Segment Digit 3[5] 3.3-V LVTTL
HEX36 PIN_E17 Seven Segment Digit 3[6] 3.3-V LVTTL
HEX37 PIN_D22 Seven Segment Digit 3[7] , 3.3-V LVTTL
HEX40 PIN_F18 Seven Segment Digit 4[0] 3.3-V LVTTL
HEX41 PIN_E20 Seven Segment Digit 4[1] 3.3-V LVTTL
HEX42 PIN_E19 Seven Segment Digit 4[2] 3.3-V LVTTL
HEX43 PIN_J18 Seven Segment Digit 4[3] 3.3-V LVTTL
HEX44 PIN_H19 Seven Segment Digit 4[4] 3.3-V LVTTL
HEX45 PIN_F19 Seven Segment Digit 4[5] 3.3-V LVTTL
HEX46 PIN_F20 Seven Segment Digit 4[6] 3.3-V LVTTL
HEX47 PIN_F17 Seven Segment Digit 4[7] , 3.3-V LVTTL
HEX50 PIN_J20 Seven Segment Digit 5[0] 3.3-V LVTTL
HEX51 PIN_K20 Seven Segment Digit 5[1] 3.3-V LVTTL
HEX52 PIN_L18 Seven Segment Digit 5[2] 3.3-V LVTTL
HEX53 PIN_N18 Seven Segment Digit 5[3] 3.3-V LVTTL
HEX54 PIN_M20 Seven Segment Digit 5[4] 3.3-V LVTTL
HEX55 PIN_N19 Seven Segment Digit 5[5] 3.3-V LVTTL
HEX56 PIN_N20 Seven Segment Digit 5[6] 3.3-V LVTTL
HEX57 PIN_L19 Seven Segment Digit 5[7] , DP 3.3-V LVTTL
DE10-Lite 29 Www.terasic.com

www.terasic.com

User Manual

June 5, 2020



http://www.terasic.com/
http://www.terasic.com/
http://www.terasic.com/

3.5 Using 2x20 GPIO Expansion Headers

The board has one 40-pin expansion headers. Each header has 36 user pins connected directly to the
MAX 10 FPGA. It also comes with DC +5V (VCC5), DC +3.3V (VCC3P3), and two GND pins.
Both 5V and 3.3V can provide a total of SW power.

Figure 3-18 shows the related schematics. Table 3-7 shows the pin assignment of GP10O headers.
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PIN_V10
PIN_V9
PIN_V8
PIN_V7
PIN_W6

PIN_W5
PIN_AA14
PIN_W12
PIN_AB12
PIN_AB11
PIN_AB10
PIN_AA9

PIN_AAS

PIN_AA7
PIN_AA6
PIN_AAS
PIN_AB3
PIN_AB2

Figure 3-18 I/O distribution of the expansion headers
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Table 3-7 Show all Pin Assignment of Expansion Headers

‘ FPGA Pin No. Description ‘ I/O Standard
GPIO_O PIN_V10 GPIO Connection [0] 3.3-V LVTTL
GPIO_1 PIN_W10 GPIO Connection [1] 3.3-V LVTTL
GPIO_2 PIN_V9 GPIO Connection [2] 3.3-V LVTTL
GPIO_3 PIN_W9 GPIO Connection [3] 3.3-V LVTTL
GPIO_4 PIN_V8 GPIO Connection [4] 3.3-V LVTTL
GPIO_5 PIN_W8 GPIO Connection [5] 3.3-V LVTTL
GPIO_6 PIN_V7 GPIO Connection [6] 3.3-V LVTTL
GPIO_7 PIN_W7 GPIO Connection [7] 3.3-V LVTTL
GPIO_8 PIN_W6 GPIO Connection [8] 3.3-V LVTTL
GPIO_9 PIN_V5 GPIO Connection [9] 3.3-V LVTTL
GPIO_10 PIN_W5 GPIO Connection [10] 3.3-V LVTTL
GPIO_11 PIN_AA15 GPIO Connection [11] 3.3-V LVTTL
GPIO_12 PIN_AA14 GPIO Connection [12] 3.3-V LVTTL
GPIO_13 PIN_W13 GPIO Connection [13] 3.3-V LVTTL
GPIO_14 PIN_W12 GPIO Connection [14] 3.3-V LVTTL
GPIO_15 PIN_AB13 GPIO Connection [15] 3.3-V LVTTL
GPIO_16 PIN_AB12 GPIO Connection [16] 3.3-V LVTTL
GPIO_17 PIN_Y11 GPIO Connection [17] 3.3-V LVTTL
GPIO_18 PIN_AB11 GPIO Connection [18] 3.3-V LVTTL
GPIO_19 PIN_W11 GPIO Connection [19] 3.3-V LVTTL
GPIO_20 PIN_AB10 GPIO Connection [20] 3.3-V LVTTL
GPIO_21 PIN_AA10 GPIO Connection [21] 3.3-V LVTTL
GPIO_22 PIN_AA9 GPIO Connection [22] 3.3-V LVTTL
GPIO_23 PIN_Y8 GPIO Connection [23] 3.3-V LVTTL
GPIO_24 PIN_AAS8 GPIO Connection [24] 3.3-V LVTTL
GPIO_25 PIN_Y7 GPIO Connection [25] 3.3-V LVTTL
GPIO_26 PIN_AA7 GPIO Connection [26] 3.3-V LVTTL
GPIO_27 PIN_Y6 GPIO Connection [27] 3.3-V LVTTL
GPIO_28 PIN_AAG6 GPIO Connection [28] 3.3-V LVTTL
GPIO_29 PIN_Y5 GPIO Connection [29] 3.3-V LVTTL
GPIO_30 PIN_AA5 GPIO Connection [30] 3.3-V LVTTL
GPIO_31 PIN_Y4 GPIO Connection [31] 3.3-V LVTTL
GPIO_32 PIN_AB3 GPIO Connection [32] 3.3-V LVTTL
GPIO_33 PIN_Y3 GPIO Connection [33] 3.3-V LVTTL
GPIO_34 PIN_AB2 GPIO Connection [34] 3.3-V LVTTL
GPIO_35 PIN_AA2 GPIO Connection [35] 3.3-V LVTTL
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3. 6 Using Arduino Uno R3 Expansion Header

The board provides Arduino Uno revision 3 compatibility expansion header which comes with four
independent headers. The expansion header has 17 user pins (16pins GPIO and 1pin Reset)
connected directly to the MAX 10 FPGA. 6-pins Analog input connects to ADC, and also provides
DC +5V (VCC5), DC +3.3V (VCC3P3 and IOREF), and three GND pins.

Please refer to Figure 3-19 for detailed pin-out information. The blue font represents the Arduino
Uno R3 board pin-out definition.

NC
IOREF
Reset Arduino_Reset_N
VCC3P3
VCC5
GND
GND
VCC5
\

SCL SCL
SDA SDA
NC
GND
Arduino_I013 D13/SCK
Arduino_|I012  D12/MISO
Arduino_IO11  D11/MOSI
Arduino_IO10 D10/SS
Arduino_|09 D9
Arduino_|O8 D8

I

Arduino Arduino_I07 D7
Arduino_|06 D6
AO ADC_INO
- Arduino_|O5 D5
A1 ADC_IN1
B Arduino_l04 D4
A2 ADC_IN2
- Arduino_|O3 D3
A3 ADC_IN3
B ) pmmmmmemmes ' Arduino_|02 D2
A4 ADC_IN4 | o P ' _
- Lo Arduino_101  D1/TX
A5 ADC_IN5 b
B v Arduino_IO0  DO/RX
D12/MISO  Arduino_lO12 -------memmuud 1 1 R VCC5
D13/SCK  Arduing_l013 -==-===mmmmmemmd b0 e Arduino_IO11  D11/MOSI
Arduino_Reset_n -=-------------mmsl Mmoo GND

Figure 3-19 lists the all the pin-out signal name of the Arduino Uno connector. The blue font
represents the Arduino pin-out definition.
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The 16 GPIO pins are provided to the Arduino Header for digital I/O. Table 3-8 lists the all the pin
assignments of the Arduino Uno connector (digital), signal names relative to the MAX 10 FPGA.

Table 3-8 Pin Assignments for Arduino Uno Expansion Header connector

Schematic . o Specific features 1/O Standard
FPGA Pin No. Description

Signal Name For Arduino

Arduino_l100 PIN_AB5 Arduino 100 RXD 3.3-V LVTTL
Arduino_l01 PIN_ABG6 Arduino 101 TXD 3.3-V LVTTL
Arduino_l02 PIN_AB7 Arduino 102 3.3-V LVTTL
Arduino_l0O3 PIN_ABS Arduino 103 3.3-V LVTTL
Arduino_l04 PIN_AB9 Arduino 104 3.3-V LVTTL
Arduino_105 PIN_Y10 Arduino 105 3.3-V LVTTL
Arduino_106 PIN_AA1l Arduino 106 3.3-V LVTTL
Arduino_107 PIN_AA12 Arduino 107 3.3-V LVTTL
Arduino_108 PIN_AB17 Arduino 108 3.3-V LVTTL
Arduino_109 PIN_AA17 Arduino 109 3.3-V LVTTL
Arduino_1010 PIN_AB19 Arduino 1010 SS 3.3-V LVTTL
Arduino_1011 PIN_AA19 Arduino 1011 MOSI 3.3-V LVTTL
Arduino_l012 PIN_Y19 Arduino 1012 MISO 3.3-V LVTTL
Arduino_1013 PIN_AB20 Arduino 1013 SCK 3.3-V LVTTL
Arduino_1014 PIN_AB21 Arduino 1014 SDA 3.3-V LVTTL
Arduino_1015 PIN_AA20 Arduino 1015 SCL 3.3-V LVTTL
ARDUINO_RESET_N |PIN_F16 Reset signal, low active. 3.3V SCHMITT

TRIGGER"

Besides 16 pins for digital GP10O, there are also 6 analog inputs on the Arduino Uno R3 Expansion
Header (ADC_INO ~ ADC_IN5). Consequently, we use MAX 10 FPGA ADC on the board for
possible future analog-to-digital applications. We will introduce in the next section.
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3.7 A/D Converter and Analog Input

The DE10-Lite board has eight analog inputs are connected to MAX 10 FPGA ADC1, through a
1x6 and a 1x2 header input, wherein the 1x2 header is reserved and not mounted with parts.

Any analog inputs signals sourced through the Arduino header JP8 are first filtered by the Analog
Front-End circuit. This circuit scales the maximum allowable voltage per the Arduino specification
(5.0V) to the maximum allowable voltage per the MAX 10 FPGA ADC IP block (2.5V).

These Analog inputs are shared with the Arduino’'s analog input pin (ADC_INO ~ ADC_IN5),
Figure 3-20 shows the connections between the Arduino Analog input and FPGA.

NC
GND
| | Arduino_1013
NC Arduino_lO12
IOREF Arduino_lO11
Arduino_Reset_n Arduino_lO10
VCC3P3 Arduino_|O9
VCC5 . Arduino_lO8
— NG Arduino
I p GND M| | Arduino_IO7
VCC5 Arduino_lO6
®
- 2 Arduino_lO5
m 1 0 . ADC_INO Arduino_|O4
p ‘ ADC_IN1 Arduino_lO3
Analog ADC_IN2 Arduino_l02
Front-End ADC_IN3 Arduino_|O1
‘ ADC_IN4 Arduino_|O0
\ y ADC_INS
ArdumojOfQ-----------»-3 .................... VCC5
ArdUInG._JOF3 sesssssosmennnati § 1 liccoscmentiessnsiasinis Arduino_lO11
Arduino_Reset_n «----s=mseremmamead e GND
Figure 3-20 Connections between the Arduino Analog input and MAX 10 FPGA
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3.8 Using VGA

The DE10-Lite board includes a 15-pin D-SUB connector for VGA output. The VGA
synchronization signals are provided directly from the MAX 10 FPGA, and a 4-bit DAC using
resistor network is used to produce the analog data signals (red, green, and blue). The associated
schematic is given in Figure 3-21 and can support standard VGA resolution (640x480 pixels, at 25
MHz).

VGA_GO | 8:8:5
VGA_G1

VGA_G2 \'AAZ
VGA_G3 VV,V

VGA_BO | i:i:i
VGA_B1

VGA B2 \f\/\/
Voa s VVV]

| | vea_vs \/\/\/
VGA_HS
VWV

AITERAY
max10

Figure 3-21 Connections between the VGA and MAX 10 FPGA

The timing specification for VGA synchronization and RGB (red, green, blue) data can be easily
found on website nowadays. Figure 3-21 illustrates the basic timing requirements for each row
(horizontal) displayed on a VGA monitor. An active-low pulse of specific duration is applied to the
horizontal synchronization (hsync) input of the monitor, which signifies the end of one row of data
and the start of the next. The data (RGB) output to the monitor must be off (driven to 0 V) for a
time period called the back porch (b) after the hsync pulse occurs, which is followed by the display
interval (c). During the data display interval the RGB data drives each pixel in turn across the row
being displayed. Finally, there is a time period called the front porch (d) where the RGB signals
must again be off before the next hsync pulse can occur. The timing of vertical synchronization
(vsync) is similar to the one shown in Figure 3-22, except that a vsync pulse signifies the end of
one frame and the start of the next, and the data refers to the set of rows in the frame (horizontal
timing). Table 3-9 and Table 3-10 show different resolutions and durations of time period a, b, c,
and d for both horizontal and vertical timing.

The pin assignments between the MAX 10 FPGA and the VGA connector are listed in Table 3-11.
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DATA

HSYNC

Back porch (b)
|

Front porch (d)

Display interval (c)

>

RGB

¥ N

»| Sync (a)

Figure 3-22 VGA horizontal timing specification

Table 3-9 VGA Horizontal Timing Specification

VGA mode Horizontal Timing Spec
Configuration Resolution(HxV) a(pixel | b(pixel | c(pixel | d(pixel | Pixel clock(MHz)
clock clock clock clock
cycle) cycle) cycle) cycle)
VGA(60Hz) 640x480 96 48 640 16 25
Table 3-10 VGA Vertical Timing Specification
VGA mode Vertical Timing Spec
Configuration Resolution(HxV) a(lines) | b(lines) | c(lines) | d(lines) | Pixel clock(MHz)
VGA(60Hz) 640x480 2 33 480 10 25

Table 3-11 Pin Assignment of VGA

Signal Name FPGA Pin No. | Description I/O Standard
VGA RO PIN_AA1 VGA Red[0] 3.3-V LVTTL
VGA R1 PIN_V1 VGA Red[1] 3.3-V LVTTL
VGA_R2 PIN_Y2 VGA Red[2] 3.3-V LVTTL
VGA_R3 PIN_Y1 VGA Red[3] 3.3-V LVTTL
VGA_GO PIN_W1 VGA Green[0] 3.3-V LVTTL
VGA_G1 PIN_T2 VGA Green[1] 3.3-V LVTTL
VGA_G2 PIN_R2 VGA Green[2] 3.3-V LVTTL
VGA_G3 PIN_R1 VGA Green[3] 3.3-V LVTTL
VGA BO PIN_P1 VGA Blue|0] 3.3-V LVTTL
VGA B1 PIN_T1 VGA Blue[1] 3.3-V LVTTL
VGA B2 PIN_P4 VGA Blue[2] 3.3-V LVTTL
VGA B3 PIN_N2 VGA Blue[3] 3.3-V LVTTL
VGA_HS PIN_N3 VGA Horizontal sync 3.3-V LVTTL
VGA_VS PIN_N1 VGA Vertical sync 3.3-V LVTTL
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3.9 Using SDRAM

The board features 64MB of SDRAM with a single 64MB (32Mx16) SDRAM chip. The chip
consists of 16-bit data line, control line, and address line connected to the FPGA. This chip uses the
3.3V LVCMOS signaling standard. Connections between the FPGA and SDRAM are shown in
Figure 3-23, and the pin assignment is listed in Table 3-12. Detailed information on using the
SDRAM is available on the manufacturer’s website, or under the \Datasheets\SDRAM folder on the
DE10-Lite System CD.

32Mx16 SDRAM
DRAM_DQ[15.0] _ [SP
DRAM_ADDR[12..0] _ PNFPRY
DRAM_BA[1.0] _ FINEI)
— DRAM CLK IO
ZA\, I:] = A DRAM_CKE WGP
DRAM_LDOM __ FTfell
1 0 DRAVM_UDQM ___ RUstelY]
MA x DRAM_WE N (2
DRAM_CAS N (IS
DRAM_RAS N IS
DRAM_CS N [JIeS

Figure 3-23 Connections between the SDRAM and MAX 10 FPGA
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Table 3-12 Pin Assignment of SDRAM

Signal Name FPGA Pin No. | Description
DRAM_ADDRO PIN_U17 SDRAM Address[0] 3.3-V LVTTL
DRAM_ADDR1 PIN_W19 SDRAM Address[1] 3.3-V LVTTL
DRAM_ADDR?2 PIN_V18 SDRAM Address[2] 3.3-V LVTTL
DRAM_ADDR3 PIN_U18 SDRAM Address[3] 3.3-V LVTTL
DRAM_ADDR4 PIN_U19 SDRAM Address[4] 3.3-V LVTTL
DRAM_ADDR5 PIN_T18 SDRAM Address[5] 3.3-V LVTTL
DRAM_ADDRG6 PIN_T19 SDRAM Address[6] 3.3-V LVTTL
DRAM_ADDR7 PIN_R18 SDRAM Address[7] 3.3-V LVTTL
DRAM_ADDRS PIN_P18 SDRAM Address|[8] 3.3-V LVTTL
DRAM_ADDR9 PIN_P19 SDRAM Address[9] 3.3-V LVTTL
DRAM_ADDR10 | PIN_T20 SDRAM Address[10] 3.3-V LVTTL
DRAM_ADDR11 | PIN_P20 SDRAM Address[11] 3.3-V LVTTL
DRAM_ADDR12 | PIN_R20 SDRAM Address[12] 3.3-V LVTTL
DRAM_DQO PIN_Y21 SDRAM Data[0] 3.3-V LVTTL
DRAM_DQ1 PIN_Y20 SDRAM Data[1] 3.3-V LVTTL
DRAM_DQ2 PIN_AA22 SDRAM Data[2] 3.3-V LVTTL
DRAM_DQ3 PIN_AA21 SDRAM Data[3] 3.3-V LVTTL
DRAM_DQ4 PIN_Y22 SDRAM Data[4] 3.3-V LVTTL
DRAM_DQ5 PIN_W22 SDRAM Data[5] 3.3-V LVTTL
DRAM_DQ6 PIN_W20 SDRAM Data[6] 3.3-V LVTTL
DRAM_DQ7 PIN_V21 SDRAM Data[7] 3.3-V LVTTL
DRAM_DQ8 PIN_P21 SDRAM Data[8] 3.3-V LVTTL
DRAM_DQ9 PIN_J22 SDRAM Data[9] 3.3-V LVTTL
DRAM_DQ10 PIN_H21 SDRAM Data[10] 3.3-V LVTTL
DRAM_DQ11 PIN_H22 SDRAM Data[11] 3.3-V LVTTL
DRAM_DQ12 PIN_G22 SDRAM Data[12] 3.3-V LVTTL
DRAM_DQ13 PIN_G20 SDRAM Data[13] 3.3-V LVTTL
DRAM_DQ14 PIN_G19 SDRAM Data[14] 3.3-V LVTTL
DRAM_DQ15 PIN_F22 SDRAM Data[15] 3.3-V LVTTL
DRAM_BAO PIN_T21 SDRAM Bank Address|0] 3.3-V LVTTL
DRAM_BA1l PIN_T22 SDRAM Bank Address[1] 3.3-V LVTTL
DRAM_LDQM PIN_V22 SDRAM byte Data Mask[0] 3.3-V LVTTL
DRAM_UDQM PIN_J21 SDRAM byte Data Mask([1] 3.3-V LVTTL
DRAM_RAS_N PIN_U22 SDRAM Row Address Strobe 3.3-V LVTTL
DRAM_CAS_N PIN_U21 SDRAM Column Address Strobe 3.3-V LVTTL
DRAM_CKE PIN_N22 SDRAM Clock Enable 3.3-V LVTTL
DRAM_CLK PIN_L14 SDRAM Clock 3.3-V LVTTL
DRAM_WE_N PIN_V20 SDRAM Write Enable 3.3-V LVTTL
DRAM_CS_N PIN_U20 SDRAM Chip Select 3.3-V LVTTL
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3. 10 Using Accelerometer Sensor

The board comes with a digital accelerometer sensor module (ADXL345), commonly known as
G-sensor. This G-sensor is a small, thin, ultralow power assumption 3-axis accelerometer with
high-resolution measurement. Digitalized output is formatted as 16-bit in two’s complement and
can be accessed through SPI (3- and 4-wire) and 12C digital interfaces.

With GSENSOR_CS_N signal to high, the ADXL345 is in 12C mode. With the GSENSOR_SDO
signal to high, the 7-bit 12C address for the device is 0x1D, followed by the R/W bit. This translates
to Ox3A for a write and 0x3B for a read. An alternate 12C address of 0x53 (followed by the R/W bit)
can be chosen by low the GSENSOR_SDO signal. This translates to 0xA6 for a write and OxA7 for
a read.

More information about this chip can be found in its datasheet, which is available on manufacturer’s
website or in the directory \Datasheet\G-Sensor folder of DE10-L.ite system CD.

Figure 3-24 shows the connections between the accelerometer sensor and MAX 10 FPGA. Table
3-13 lists the pin assignment of accelerometer to the MAX 10 FPGA.

MCC3P3
ADXL345
2.2K J2.2K
—{GSENSOR_SCLK r » SCL_SCLK
AEE?A ® GSENSOR_SDI » SDA_SDI_SDIO
® - GSENSOR_CS n CS n

max10 S > C8_

GSENSOR_SDO » SDO_ALT_ADDRESS

GSENSOR_INT1 INT1

GSENSOR_INT2 INT2

Accelerometer

Figure 3-24 shows the connections between the accelerometer sensor and MAX 10 FPGA.
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Table 3-13 Pin Assignment of Accelerometer Sensor

Signal Name FPGA Pin No. | Description I/O Standard
I12C serial data
GSENSOR_SDI PIN_V11 SPI serial data input (SPI 4-wire) 3.3-V LVTTL
SPI serial data input and output (SPI 3-wire)
SPI serial data output (SPI 4-wire)
GSENSOR_SDO | PIN_V12 3.3-V LVTTL
- - Alternate 12C address select
12C/SPI mode selection:
1: SPI idle mode / 12C communication enabled
GSENSOR _CS n | PIN_AB16 o ) 3.3-V LVTTL
-~ - 0: SPI communication mode / [2C disabled
SPI Chip Select
12C serial clock
GSENSOR_SCLK | PIN_AB15 ) ) 3.3-V LVTTL
- - SPI serial clock (3- and 4-wire)
GSENSOR_INT1 |PIN_Y14 Interrupt pin 1 3.3-VLVTTL
GSENSOR_INT2 |PIN_Y13 Interrupt pin 2 3.3-VLVTTL
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Chapter 4
DE 10-Lite System Builder

This chapter describes how users can create a custom design project with the tool named DE10-L.ite
System Builder.

4. 1 Introduction

The DE10-Lite System Builder is a Windows-based utility. It is designed to help users create a
Quartus Il project for DE10-Lite within minutes. The generated Quartus Il project files include:

Quartus Il project file (.qpf)

Quartus 1 setting file (.qsf)

Top-level design file (.v)

Synopsis design constraints file (.sdc)

Pin assignment document (.htm)

The above files generated by the DE10-Lite System Builder can also prevent occurrence of
situations that are prone to compilation error when users manually edit the top-level design file or
place pin assignment. The common mistakes that users encounter are:

Board is damaged due to incorrect bank voltage setting or pin assignment.

Board is malfunctioned because of wrong device chosen, declaration of pin location or direction is
incorrect or forgotten.

Performance degradation due to improper pin assignment.
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4. 2 General Design Flow

This section provides an introduction to the design flow of building a Quartus Il project for
DE10-Lite under the DE10-Lite System Builder. The design flow is illustrated in Figure 4-1.

The DE10-Lite System Builder will generate two major files, a top-level design file (.v) and a
Quartus 11 setting file (.qsf) after users launch the DE10-Lite System Builder and create a new
project according to their design requirements.

The top-level design file contains a top-level Verilog HDL wrapper for users to add their own
design/logic. The Quartus Il setting file contains information such as FPGA device type, top-level
pin assignment, and the 1/O standard for each user-defined 1/O pin.

Finally, the Quartus Il programmer is used to download .sof file to the development board via JTAG
interface.

! | )

Launch Quartus Il
and Open Project

Launch

System Builder

Create New Add User
System Builder Project Design/Logic
Generate Quartus I Compile to
Project and Document

generate .SOF

Configure FPGA

Figure 4-1 Design flow of building a project from the beginning to the end
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4. 3 Using DE10-Lite System Builder

This section provides the procedures in details on how to use the DE10-Lite System Builder.

B Install and Launch the DE10-Lite System Builder

The DE10-Lite System Builder is located in the directory: “Tools\SystemBuilder” of the DE10-L.ite
System CD. Users can copy the entire folder to a host computer without installing the utility. A
window will pop up, as shown in Figure 4-2, after executing the DE10-Lite SystemBuilder.exe on
the host computer.

DE10-Lite V1.0.0 =

AIERA System Configuration

UNIVERSITY >

PROGRAM "Wterssic.com Project Name:

DE10-Lite FPGA Board DEIOLITE
VI CLOCK [v] 7-Segment x 6
VI LEDx10 V] Switch x 10
[v] Button x 2 [v] Accelerometer
VIVGA VI SDRAM, 64MB

[V Arduino Header

2x20 GPIO Header
\None -
Prefix Name:

[ Save Setting J { Load Setting ] { Generate \ { Exit

Figure 4-2 The GUI of DE10-Lite System Builder

B Enter Project Name

Enter the project name in the circled area, as shown in Figure 4-3.

The project name typed in will be assigned automatically as the name of your top-level design
entity.
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DE10-Lite V1.0.0

Systfem Configuration

P.R.O G R A Ml "W¥.cerasic.com Project Name:

DE10-Lite FPGA Board LEJO LI
VI CLOCK [Vl 7-Segment x 6
VILEDx 10 V] Switch x 10
[v] Button x 2 [v] Accelerometer
VIVGA [VISDRAM, 64MB

[V Arduino Header

2x20 GPIO Header
|None -
Prefix Name:

[ Save Setting l [ Load Setting ] [ Generate ] { Exit

Figure 4-3 Enter the project name

B System Configuration

Users are given the flexibility in the System Configuration to include their choice of components in
the project, as shown in Figure 4-4. Each component onboard is listed and users can enable or
disable one or more components at will. If a component is enabled, the DE10-Lite System Builder
will automatically generate its associated pin assignment, including the pin name, pin location, pin

direction, and 1/O standard.

DE10-Lite V1.0.0

JAIERAN System Configuration

UNIVERSITY >

P_R.O G R A M| "Wwterasic.com Project Name:

DE10-Lite FPGA Board CEIOLITE
VI CLOCK V] 7-Segment x 6
VI LEDx 10 [V] Switch x 10
[v] Button x 2 [v] Accelerometer
VIVGA VI SDRAM, 64MB

[¥] Arduino Header

2x20 GPIO Header
[None -
Prefix Name:

[ Save Setting ] { Load Setting ] [ Generate l { Exit

[asic]

www.terasic.com

Figure 4-4 System configuration group
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B GPIO Expansion

If users connect any Terasic GP10-based daughter card to the GPIO connector(s) on DE10-L.ite, the
DE10-Lite System Builder can generate a project that include the corresponding module, as shown
in Figure 4-5. 1t will also generate the associated pin assignment automatically, including pin name,
pin location, pin direction, and /O standard.

DE10-Lite V1.0.0 =

System Configuration

UNIVERSITY y

PROGRAM "Www terasic.com PI-OJe(j> Name

DE10-Lite FPGA Board DEIOLITE

VI CLOCK [v] 7-Segment x 6
VILEDx10 [V] Switchx 10
[v] Button x 2 [v] Accelerometer
VIVGA VI SDRAM, 64MB

[V Arduino Header

2x20 GPIO Header

|D8M-GPIO -

Prefix Name: i
7

{ Save Setting ] [ Load Setting ] [ Generate ] { Exit ]

Figure 4-5 GPIO expansion group

The “Prefix Name” is an optional feature that denote the pin name of the daughter card assigned in
your design. Users may leave this field blank.
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B Project Setting Management

The DE10-Lite System Builder also provides the option to load a setting or save users’ current
board configuration in .cfg file, as shown in Figure 4-6.

DE10-Lite V1.0.0 B3

JAIERAN System Configuration

UNIVERSITY 2

PROGRAM wWww.terasic.com Pro]eo«t Name

DE10-Lite FPGA Board UEJOLTE
VI CLOCK V] 7-Segment x 6
VILEDx10 [V] Switch x 10
V] Buttonx 2 [Vl Accelerometer
VVGA VI SDRAM, 64MB

[v] Arduino Header

2x20 GPIO Header
[None -

L [l

“u“ﬂhkkk Prefix Name:

[ Save Setting ] 1 Load Setting ] I Generate l [ Exit

Figure 4-6 Project Settings

B Project Generation

When users press the Generate button as shown in Figure 4-7, the DE10-Lite System Builder will
generate the corresponding Quartus Il files and documents, as listed in Table 4-1:

DE10-Lite V1.0.0 =

IATERAN System Configuration

UNIVERSITY 2

PROGRAM Wwwterasic.com PrOJeC«t Name:

DE10-Lite FPGA Board UEILTE
vICLOCK V] 7-Segment x 6
VILEDx10 [V] Switch x 10
V] Button x 2 [v] Accelerometer
VIVGA [VISDRAM, 64MB

[v] Arduino Header

2x20 GPIO Header
{None ~

'KWH'M!PI- Prefix Name:

[ Save Setting J 1 Load Setting ] I Generate l [ Exit

Figure 4-7 Generate Quartus Project
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Table 4-1 Files generated by the DE10-Lie System Builder

No. | Filename Description
1 <Project name>.v Top level Verilog HDL file for Quartus Il
2 <Project name>.qpf Quartus Il Project File
3 <Project name>.qsf Quartus Il Setting File
4 <Project name>.sdc Synopsis Design Constraints file for Quartus Il
5 <Project name>.htm Pin Assignment Document

Users can add custom logic into the project in Quartus Il and compile the project to generate the
SRAM Obiject File (.sof).
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Chapter 5
Examples of Advanced

Demonstralions

This chapter provides examples of advanced designs implemented by RTL or Qsys on the
DE10-Lite board. These reference designs cover the features of peripherals connected to the FPGA,
such as VGA, SDRAM, and Accelerometer Sensor. All the associated files can be found in the
directory \Demonstrations of DE10-Lite System CD.

B Installation of Demonstrations

To install the demonstrations on your computer:

Copy the folder Demonstrations to a local directory of your choice. It is important to make sure the
path to your local directory contains NO space. Otherwise, it will lead to error in Nios II.

Note : Quartus 11 v16.0 or later is required for all DE10-Lite demonstrations to support MAX 10
FPGA device.

5. 1 DE10-Lite Factory Configuration

The DE10-Lite board has a default configuration bit-stream pre-programmed, which demonstrates
some of the basic features onboard. The setup required for this demonstration and the location of its
files are shown below.

Demonstration File Locations

e Project directory: \Default
e Bitstream used: DE10_LITE_Default.sof , DE10_LITE_Default.pof

DE10-Lite 48 www.terasic.com
aslc User Manual June 5, 2020

www.terasic.com


http://www.terasic.com/
http://www.terasic.com/
http://www.terasic.com/

Demonstration Setup and Instructions

e Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary.

e Execute the demo batch file “ test.bat” from the directory \Default\demo_batch\

e You should now be able to observe the 7-segment displays are showing a sequence of characters,
and the red LEDs are blinking. When putting SWO to high position and swing the board, the red
LEDs will act like gradienter.

e Press KEYO to make red LEDs and 7-segment all light up.

e If the VGA D-SUB connector is connected to a VGA display, it would show a color picture.

Restore Factory Configuration

Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary.

Execute the demo batch file “program.bat” from the directory \Default\demo_batch\

After the program is executed successfully, the program message as shown in Figure 5-1. Please
press any key to continue and the window will be closed.

Info:

€213011>:

Info:
Info:
Info:
Info:

BN C\Windows\system32\cmd exe

D:~system_cd“Demonstrations \Defaultsdemo_batch>P:valtera™lb. 1sguartusshinbdssguartus_pgn.exe —m jtag —¢ 1 —o "p;DE1@_LITE Default.pof'

Info: Running Quartus Prime Programmer
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
Info:
: Command: guartus_pgm —m jtag —c¢ 1 —o p;DE1B_LITE Default.pof

<213845>: ing programming cahle “USB-Blaster [USB-81"

sing programming file DE1B_LITE_Default.pof with checksum BxA581AFAF for device 1BMSBDAF484ESE1

{289868>: Started Programmer operation at Tue Jun 21 19:51:31 2816

{289817>: Device 1 contains JTAG ID code BxB31B58DD

Version 15.1.8 Build 185 18-21-2815 5J Standard Edition
Copyright (C> 1991-2815 Altera Corporation. All rights reserved.
Your use of Altera Corporation’s design tools. logic functions
and other software and tools, and its AMPP partner logic
functions, and any output files from any of the foregoing
Cincluding device progranming or simulation files>, and any
associated documentation or information are expressly subject

to the terms and conditions of the Altera Program License
Subscription Agreement, the Altera Quartus Prime License Agreement,
the Altera MegaCore Function License Agreement,. or other
applicable license agreement, including, without limitation,
that your use is for the sole purpose of programming logic
devices manufactured by filtera and sold by Altera or its
authorized distributors. Please refer to the applicable
agreement for further details.

Processing started: Tue Jun 21 19:51:25 2816

: Started Programmer operation at Tue Jun 21 19:51:31 2816
: Gonfiguring device index 1

Device 1 contains JTAG ID code BxB31B58DD

Configuration succeeded —— 1 deviced{s) configured
: Successfully performed operationdsd

(209061>: Ended Programmer operation at Tue Jun 21 19:51:33 2816
<289824>: Programming device 1
(2A9P11>: Successfully performed operationd{s)

¢209061>: Ended Programmer operation at Tue Jun 21 19:52:11 2816
: Quartus Prime Programmer was successful. B errors. B warnings

Peak virtual memory: 278 negahytes
Processing ende Tue Jun 21 19:52:11 2616
Elapsed time: HA:B0:46

Total CPU time ¢on all processors): BB:B8:B2

tem_cd\Demonstrations\Default deno_batch>pause

[asic]

Figure 5-1 Quartus Il Program MAX 10 CFM message
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5. 2 SDRAM Test in Nios I

There are many applications using SDRAM as a temporary storage. Both hardware and software
designs are provided to illustrate how to perform memory access in Qsys in this demonstration. It
also shows how Altera’s SDRAM controller IP accesses SDRAM and how the Nios II processor
reads and writes the SDRAM for hardware verification. The SDRAM controller handles complex
aspects of accessing SDRAM such as initializing the memory device, managing SDRAM banks,
and keeping the devices refreshed at certain interval.

B System Block Diagram

Figure 5-2 shows the system block diagram of this demonstration. The system requires a 50 MHz
clock input from the board. The SDRAM controller is configured as a 64MB controller. The
working frequency of the SDRAM controller is 120 MHz, and the Nios Il program is running on
the on-chip memory.

FPGA
O || [Gsvs

50 MHz
On- Chlp
Memory
: ' PO
= | = =
. SDRAM '

E
t
t

System Intercoment Fabric

Figure 5-2 Block diagram of the SDRAM test in Nios Il

The system flow is controlled by a program running in Nios Il. The Nios Il program writes test
patterns into the entire 64MB of SDRAM first before calling the Nios Il system function,
alt_dcache_flush_all, to make sure all of the data is written to the SDRAM. It then reads data from
the SDRAM for data verification. The program will show the progress in nios-terminal when
writing/reading data to/from the SDRAM. When the verification process reaches 100%, the result
will be displayed in nios-terminal.
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Design Tools

e Quartus 11 v16.0
e Nios Il Eclipse v16.0

Demonstration Source Code

e Quartus project directory: \SDRAM_Nios_Test
e Nios Il Eclipse directory: \SDRAM _Nios_Test \Software

Nios Il Project Compilation

e Click “Clean” from the “Project” menu of Nios II Eclipse before compiling the reference design
in Nios Il Eclipse.

Demonstration Batch File

The files are located in the director: \SDRAM _Nios_Test\demo_batch
The folder includes the following files:

e Batch file for USB-Blaster : test.bat and test.sh
e FPGA configuration file : DE10_LITE_SDRAM_Nios_Test.sof
e Nios Il program: DE10_LITE_SDRAM_Nios_Test.elf

Demonstration Setup

e Quartus 11 v16.0 and Nios Il v16.0 must be pre-installed on the host PC.

e Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary.

e Execute the demo batch file “test.bat” from the directory \SDRAM_Nios_Test\demo_batch

e After the program is downloaded and executed successfully, a prompt message will be displayed
in nios2-terminal.

e Press any button (KEYO0~KEY1) to start the SDRAM verification process. Press KEYO0 to run
the test continuously.

e The program will display the test progress and result, as shown in Figure 5-3.
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Figure 5-3 Display of progress and result for the SDRAM test in Nios Il
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5. 3 SDRAM Test in Verilog

DE10-Lite system CD offers another SDRAM test with its test code written in Verilog HDL. The
memory size of the SDRAM bank tested is still 64MB.

B Function Block Diagram

Figure 5-4 shows the function block diagram of this demonstration. The SDRAM controller uses 50
MHz as a reference clock and generates 100 MHz as the memory clock.

Test
Control

Figure 5-4 Block diagram of the SDRAM test in Verilog

RW_Test module writes the entire memory with a test sequence first before comparing the data read
back with the regenerated test sequence, which is the same as the data written to the memory.

KEYO triggers test control signals for the SDRAM, and the LEDs will indicate the test result
according to Table 5-1.

Design Tools

e Quartus 11 v16.0

Demonstration Source Code

e Project directory: \SDRAM_RTL_Test
e Bit-stream used: DE10_LITE_SDRAM_RTL_Test.sof
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Demonstration Batch File

Demo batch file folder: \SDRAM_RTL_Test\demo_batch
The directory includes the following files:

e Batch file : test.bat
e FPGA configuration file : DE10_LITE_SDRAM_RTL_Test.sof

Demonstration Setup

e Quartus Il v16.0 must be pre-installed to the host PC.

e Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary

e Execute the demo batch file “test.bat” from the directory \SDRAM_RTL_Test\demo_batch

e Press KEYO on the DE10-Lite board to start the verification process. When KEYO is pressed,
the LEDR [2:0] should turn on. When KEYO is then released, LEDR1 and LEDR?2 should start
blinking.

e After approximately 8 seconds, LEDRL1 should stop blinking and stay ON to indicate the test is
PASS. Table 5-1 lists the status of LED indicators.

e If LEDR2 is not blinking, it means 50MHz clock source is not working.

e If LEDRLI failed to remain ON after approximately 8 seconds, the SDRAM test is NG.

e Press KEYO again to repeat the SDRAM test.

Table 5-1 Status of LED Indicators

LEDR1 ON if the test is PASS after releasing KEYO
LEDR2 Blinks
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5. 4 VGA Pattern

This demonstration displays a simple blue, red and green color pattern on a VGA monitor using the
VGA output interface on DE10-Lite board. Figure 5-5 shows the block diagram of the design.

The major block called video_sync_generator generates the VGA timing signals, horizontal
synchronization, vertical synchronization and blank in standard VGA resolution (640x480 pixels, at

25 MHz).

These signals will be used in vga_controller block for RGB data generation and data output. Please
refer to the chapter 3.8 in DE10-Lite_User Manual on the DE10-Lite System CD for detailed

information of using the VGA output.

As shown in Figure 5-6, the RGB data drives each pixel in turn across the row being displayed

after the time period of back porch.

FPGA

MAX10_CLK1_50

d PLL b video_sync_generator [SlE3LEICMPY vga_controller VGA
Figure 5-5 Block diagram of the VGA Pattern demonstration
[ Name | Q& i _ 24 3 A a8 b5 68 12 @& & G 104 _

vga_pli:ul|outclk_0 ‘

VGA_VS

VGA_HS
* _|H_Coni[18.0]__0

= VGA_B[3.0]

* VGA_G[3.0]

* VGA_R[3.0]

Figure 5-6 Timing Waveform of VGA interface
Design Tools
e Quartus 11 16.0
Demonstration Source Code

e Quartus Project directory: \VGA_Pattern
e Bit-stream used: DE10 LITE VGA Pattern.sof
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Demonstration Batch File

Demo Batch File Folder: \VGA_Pattern\demo_batch
The demo batch file includes following files:

e Batch File for USB-Blaster: test.bat
e FPGA Configure File: DE10_LITE_VGA_Pattern.sof

Demonstration Setup

e Quartus Il v16.0 must be pre-installed to the host PC..

e Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary

e Connect VGA D-SUB to a VGA monitor.

o Execute the demo batch file “test.bat” from the directory : \WVGA_Pattern\demo_batch\

e The VGA monitor will display a color pattern.

e Figure 5-7 illustrates the setup for this demonstration.

VGA Out

Figure 5-7 The setup for the VGA Pattern demonstration
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5.5 G-Sensor

This demonstration illustrates how to use the digital accelerometer on the DE10-Lite board to
measure the static acceleration of gravity in tilt-sensing applications. As the board is tilted from left
to right and right to left, the digital accelerometer detects the tilting movement and displays it on the
LEDs.

B Function Block Diagram

Figure 5-8 shows the system block diagram of this demonstration. In this system, the accelerometer
is controlled through a 3-wire SPI. Before reading any data from the accelerometer, the controller
sets 1 on the SPI bit in the Register 0x31 — DATA_FORMAT register. The 3-wire SPI Controller
block reads the digital accelerometer X-axis value, to determine the tilt of the board. The LEDs are
lit up as if they were a bubble, floating to the top of the board.

DE10-LITE Board

FPGA

d LED Driver ’-—> LED

< > 3-wire SPI |
eten| Controller ﬂ

Figure 5-8 Block diagram of the G-Sensor

Design Tools

e Quartus I1v16.0
Demonstration Source Code

e Project directory: \GSensor
e Bitstream used: DE10_LITE_GSensor.sof
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Demonstration Batch File

Demo batch file folder: \GSensor\demo_batch
The directory includes the following files:

o Batch file: test.bat
e FPGA configuration file: DE10_LITE_GSensor.sof

Demonstration Setup

e Quartus Il v16.0 must be pre-installed to the host PC.

e Connect the DE10-Lite board (J3) to the host PC with a USB cable and install the USB-Blaster
driver if necessary

e Execute the demo batch file “test.bat” from the directory \GSensor\demo_batch. This will load
the demo into the FPGA.

e Tilt the DE10-Lite board from side to side and observe the result on the LEDs.
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5. 6 ADC Measurement

This demonstration shows how to use the FPGA on-die ADC to measure the input power voltage
from the six analog input pins among the Arduino connector. The measured voltage is displayed on
the six 7-segment display. Figure 5-9 shows the block diagram of this demonstration. The main
control uses the Altera ADC IP to retrieve the 12-bit digitalized analog value according the channel
specified by the SWITCH on the DE10-Lite. The input voltage can be calculated based on the
12-bit digital value. Finally, the voltage value will be display on the 7-segment display by using the
7-segment controller.

The 12-bit represents 0~2.5V input voltage to the ADC hardware. In the ADC front-end circuit, the
output voltage is half of the input voltage. So the input voltage to the ARDUINO analog input can
be calculated with the formula listed below:

VOLinput= (12-bit integer value)/4095 x 2.5 x 2 = (12-bit integer value)/4095 x 5.0

A0'G-0:UIA

Z/UA=INOA
unouID pus Juol4 DAy
alempieH 0QV

induj Bojeuy
ONINAYY

SWITCH AR
Display

Figure 5-9 Block diagram of the ADC measurement demonstration

In the demonstration, a Signal Tap is also provided to display the retrieved 12-bit digitalized value
and the calculated voltage for the input power to the ARDUINO analog input as shown in Figure
5-10.

I Name P2 T v 1 73
+|- cur_adc_ch[4..0] i 01h
+/-adc_sample_data[11..0] ATSh ! }( ATDh
+vol[12..0] 3273 ! b 3275
response_valid
Figure 5-10 Signal Tap of ADC
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Design Tools
e Quartus 11 16.0

Demonstration Source Code

e Quartus Project directory: \ADC_RTL
e Bitstream used: DE10_L.ite.sof

Demonstration Batch File

Demo Batch File Folder: \ADC_RTL \demo_batch
The demo batch file includes following files:

e Batch File for USB-Blaster: test.bat
e FPGA Configure File: DE10_L.ite.sof

Demonstration Setup

e Quartus 11 16.0 must be pre-installed to the host PC..

e Connect USB Blaster to the DE10-Lite board and install USB Blaster driver if necessary.

e Execute the demo batch file “test.bat” from the directory\ADC_RTL\demo_batch.

e Use SW[2:0] to specify measured analog input channel.

e The measured channel and voltage will be displayed on the 7-segment display as shown in
Figure 5-11.

Channel Voltage

Figure 5-11 7-Segment display the measured channel and voltage
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Chapter 6
Programming the Configuration

Flash Memory

This tutorial provides comprehensive information that will help you understand how to configure
DE10-Lite Board using internal configuration mode. The MAX 10 device on DE10-Lite Board
supports single and dual image boot. This tutorial explains the details of the dual image boot. The
following sections provide a quick overview of the design flow.

Please note that if you are using the dual image boot function on the DE10-Lite board, you
will need to solder the JP5 2-pin header (pitch 0.100" (2.54 mm)) by yourself.

The JP5 position please refer to the Figure 6-1.

The settings of JP5 are described in Table 6-1.

B[aéh

Figure 6-1 JP5 position on the DE10-Lite board.

m@@@p

P T T e T T T I T

Table 6-1 JP5 Jumper setting instructions

‘ I Open (default) Boot from image 0
‘ Close Boot from image 1
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6. 1 Internal Configuration

The internal configuration scheme for all MAX 10 devices except for 10M02 device consists of the
following mode:

e Dual Compressed Images — configuration image is stored as imageO and imagel in the
configuration flash memory (CFM).

e Single Compressed Image.

e Single Compressed Image with Memory Initialization.

e Single Uncompressed Image.

e Single Uncompressed Image with Memory Initialization.

In dual compressed images mode, you can use the BOOT_SEL pin to select the configuration
image.

The High-Level Overview of Internal Configuration for MAX 10 Devices as shown in Figure 6-2.

MAX 10 Device

Configuration Data

Internal
Configuration
JTAG
In-System Programming

Figure 6-2 High-Level Overview of Internal Configuration for MAX 10 Devices

Before internal configuration, we need to program the configuration data into the configuration
flash memory (CFM). The CFM will be part of the programmer object file (.pof) programmed into
the internal flash through the JTAG In-System Programming (ISP).

During internal configuration, MAX 10 devices load the configuration RAM (CRAM) with
configuration data from the CFM. Both of the application configuration images, image 0 and image
1, are stored in the CFM. The MAX 10 device loads either one of the application configuration
image from the CFM. If an error occurs, the device will automatically load the other application
configuration image. Remote System Upgrade Flow for MAX 10 Devices is shown in Figure 6-3.
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Reconfiguration Sample _ Reconfiguration

N
A

BOOT Pin

Boot_SEL=0 Boot_SEL=1

First Error Occurs

First Error Occurs

Second Error Occurs |

l

Reconfiguration

Figure 6-3 Remote System Upgrade Flow for MAX 10 Devices

The operation of the remote system upgrade feature detecting errors is as follows:

1.

[asic]

After powering-up, the device samples the BOOT_SEL pin to determine which application
configuration image to boot. The BOOT_SEL pin setting can be overwritten by the input
register of the remote system upgrade circuitry for the subsequent reconfiguration.

If an error occurs, the remote system upgrade feature reverts by loading the other application
configuration image. The following lists the errors that will cause the remote system upgrade
feature to load another application configuration image:

Internal CRC error
User watchdog timer time-out

Once the revert configuration completes and the device is in the user mode, you can use the
remote system upgrade circuitry to query the cause of error and which application image failed.
If a second error occurs, the device waits for a reconfiguration source. If the auto-reconfig is
enabled, the device will reconfigure without waiting for any reconfiguration source.
Reconfiguration is triggered by the following actions:

Driving the nSTATUS low externally
Asserting internal or external nCONFIG low
Asserting RU_nCONFIG low (Avalon-MM interface signal)
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6. 2 Using Dual Compressed Images

The internal configuration scheme for all MAX 10 devices except for 10M02 device consists of the
following mode:

e Dual Compressed Images — configuration image is stored as image 0 and image 1 in the
configuration flash memory(CFM).
e Single Compressed Image.

This section will just introduce how to use MAX 10 device Dual Compressed Images feature. If you
don’t need this feature, skip this section

Before using MAX 10 Dual Compressed Images feature, users need to set these two image files’
Quartus Il projects as follows:

e Add dual configuration IP.
e Modify Configuration Mode in device setting.

First of all, a Dual Configuration IP should be added in an original project, so that the .pof file
can be programmed into CFM through it. Here we use a demonstration named *‘Led Breathe' as
an example to add Altera Dual Configuration IP to the project:

1. Open Quartus project and choose Tools > Qsys to open Qsys system wizard as shown in Figure
6-4.

(T Quartus Prime Standard Edition - D/systern_cd/Demonstrations/Dual_boot/Led8reathe/DEL0_LITE_LedBreathe - DEL0_LITE_LedBreathe | [
Fie Edit View Project Assignments Processing Window  Help Search altera.com [
» ;
D = ... DE10_LITE_LedB Run Simulation Tool ke P. Q e i!t » [_“_!] ™
Generate Simulator Setup Script for IP...
Project Navigator [y Hierarchy — ~|=[D 5 ‘\P Catalog @a =
4. Launch Library Compiler =
EoGynetance) g, Launch Design Space Explorer I b *E = o X =
A% MAX 10: 10MS0DAF4BACTG © Tecusst g ney | 4 i nstateap
s TimeQuest Timin: nalyzer
BB DE10_LITE_LedBreathe & 9 4 Project Directory
Advisors » > System
I 4 Library I
% Chip Planner

» Basic Functions

& &

Design Partition Planner > DSP

Metlist Viewers L4 » Interface Protocols

SignalTap Il Logic Analyzer » Memory Interfaces and Controllers
» Processors and Peripherals
In-System Memory Content Editor

Logic A nterf Edit > University Program
— - ogic Analyzer Interface Editor
Kl m ¢ & - e Search for Partner IP

Tasks Compilation ~|=m@s SignalPrabe Pins. .

Task W  Programmer

4 P Compik Design ITAG Chain Debugger

D
-
B
In-System Sources and Probes Editor
i3
&
L2

> P Analysis & Synthesis Fault Injection Debugger

System Debugging Tools »

» P Fitter (Place & Route)

> B Assembler (Generate nronramming files) | 3 IP Catalog )
s o = » + Add

e Nios |l Software Build Tools for Eclipse
@ BEm o B 1) (o8 7varex)
[EE Type ID Message A TelScripts...
Customize.
%u Options.
g System Processing License Sstup,
Ok Install Devices. 0% R
Figure 6-4 Select Qsys menu and click
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2. Please choose Library > Basic Function> Configuration and Programming > Altera Dual
Configuration to open wizard of adding dual boot IP. See Figure 6-5 and Figure 6-6.

T

File Edit System Generate View Tools Help

IF Catelng 2% = AddressMap &% | Intercomnect Requirement: &% =
- 2 o|[ 5= o q =
x| [a] [ System: wnsaved
EY X [=] [ ] 4] syste
Libraxy n + U Comn.. Name Description Export Clock Baze
B”chfimmhicm L | g ek 0 Clock Soure
i .
i Brid ges and Adaptors X c].k_j.n Clock Input clk exported
- Clocks; PLLs and Ressts - . clk_in_reset Feszt Input reset
=+ Configuration and Programming .I clk Clock Output clk 0
b @ clk_rest Reszt Cutput
FY
v
A lters Dnaal Configuration ¥
e
- @ hltera Parallel Flash Loader
e -
4 m ] < U >
R ”'I“' fh— W W Current filter:
[Edit... | [ add.. |
o= -2
8 == Type Path Message
'Q (unsaved [unsaved qsys® o
G ke =
G resst =[{l« [ i | >

ot Wona

Figure 6-5 Select Altera Dual Configuration IP and click.

-
s Altera Dual Configuration - dual_boot g
|

“ Altera Dual Configuration :
|

|" Block. Disgram \ |" Parameters

Show signsls Clock frequency: 50 0| MHz

dual_boaot 0

avalon

alttera_dual_boot

Figure 6-6 Open wizard and click Finish.
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3. Click Finish to close the wizard and return to the Qsys window. Choose dual_boot_0 and click
right key to select Rename it to dual_boot, and connect the clk and nreset to clk_0.clk and
clk_0.clk_reset as shown in Figure 6-7.

%'? Qsys - unsaved.gsys* (D.\syslem_cd\DemDnslrations\DeFﬂult\unsaved.qsys_ lEI&IQ

Eile Edit System Generate View Tools Help

- TP Catalog 52 = t: Bystern Contents 52 } AddressMap 30 | Tnterconnect Reguirements 52 | il = |
1 X x| |a ! System: mnz=wved Path: dual_bootnresst
Project - * |Us  Comn. Neme Dieseription Export Clock
-1 New Component.. ‘
Library x
[=-Basic Fonctions =
- Arithmetic = =
r-Birid ges and Adaptors =
et Clocks; FLLs and Resets -
= Configuration and Programmdng
e M hd
- = Reset Input Double-click to export  [C1K
. avalon | valon Memory Mapped Slave [clk]
- .
- .
. a m r
- @ Altera Parallel Flash Loader —
- ”-I-'" fh’- W Cuxxent filler:
. -

< - nm | 3 oﬁz Messages 5 _ ﬂ' =
Wew... | | Edit.. & Add.. Tupe Path Message

1= 1 Warning
m Device Famil &% | e m L3N unsaved.dval_boot |dual_boot.avalon must be comnected to an Avalon-MM master
B = i -~
=
- “ Ll r
o, e

Figure 6-7 Rename and connect dual boot IP OK

4. Choose Generate > Generate HDL.. and click Generate then pop a window as shown in
Figure 6-8. Click Save it as dual_boot.gsys and the generation start. If there is no error in the
generation, the window will show successful as shown in Figure 6-9.

) S |
- : el
5= Generstion — A — A gt k :

[ Symthesis |
Symnthesiz files are nsed to compile the system 4 a Quartos Prime project.

Create HDL design files for synthesis: | Verilng - |
[ Create timing and resource estimates for third-party EDAL symthesis tools.
Create block synbol file { bsf)

i [* simulation

The simulation model contains generated HDL files for the simulator, and may inclode simulation-ondy featores.

Bimulation sripts for this = = e = |
wa Save System
. . 3 - .
FDHDW th.e. gmdfmce n | Save changes? M |-sefup-simulztion and I
1p-make-simsoript to Save System | -
Create simulation model: —
Save changes to unnamed? Clome

| Save | lDon'tSa\re][ Cancel F D

Crenexate ” Cancel ]

Figure 6-8 Generate and Save Qsys.
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g AN )

@ Progress: Validating

@ Progress: Done reading input file

/4 Wamning: duwal_boot.dual_boot: dvel_boot.avalon must be connected to an Avalon-MM ma
@ Iufo: dual_boot: Generating dual_boot "dual_boot" for QUARTUS _SYNTH

@ Info: dwal_boot: generating top-level entity alters_dual_boot

@ Info: dwal_boot: "dual_boot" instantiated altexa_duval boot "dval_boot"

@ Info: rst_controllex: "duwal_boot" instantiated alters_veset_comtroller "rst_controllex”
@ Info: dwal_boot: Done "dwal_boot" with 3 modules, 7 files

@ Iufo: gaye- generate succeeded.

@ Info: Finished: Create HDL design files for symthesis

< n | b

0, Generate: completed with wamings.

m

1

Btop

Figure 6-9 Generate completed.

5. Click Close and Finish to return to the window and add the dual_boot gsys into the top file as
shown in Figure 6-10, and add the dual_boot.qip file to the project and save.

Bdual_boot ul (
LClk_clk (Max10_CLK1l_500, J/ clk.clk
.reset_reset_n (1°bl) S/ oreset.reset_n

Figure 6-10 Add the dual_boot module in top file.

Secondly, the project needs to be set before the compilation. After adding dual_boot IP successfully,
please set the project mode as Internal Configuration mode, detail steps are as follows:

1. Choose Assignments > Device to open Device windows shown in Figure 6-11.

Device Board

Select the family and device you want to target for compilation.
“ou can ingtall additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Suppert List webpage.

Device family Show in "Available devices' list

Eamily: [MAX 10 (DA/DFIDC/SAISC) ~]  Package: [FBGA

Devices: [AII '] Pin count: [484

Core Speed grade: | A
Target device ore Speed grade: [ ny

N fitter:
Auto device selected by the Fitter ame TILET:

@ Specific device selected in *Available devices’ list Show advanced devices

Other: n/a Device and Pin Options...

Available devices:

Hame Core Voltage LEs Memory Bits Embedded multiplier 9-bit elements Global Clocks
10M40DAF484CTG 1.2V 40358 1290240 250 20

10M40DAF484CEG 1.2V 40388 1290240 250 20
4

Migration Devices...| 0 migratien devices selected

Figure 6-11 Open Device window...
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2. Click Device and Pin Opinions to open the Device and Pin Opinions windows, and in the
Configuration tab, Set the Configuration Scheme to Internal Configuration and the
Configuration Mode to Dual Compressed Images. Check the Option of Generate
compressed bitstreams. shown in Figure 6-12.

& oevee v cpies o0 e oo R
Category:
General Configuration
Configuration
Programming Files Specify the device configuration =cheme and the configuration device.
Unused Pins
Duak-Purpose Pins Configuration scheme: | Internal Configuration hd
Capacitive Loading Configuration mode: | Dual Compressed Images (512Kbits UFM) -]
Board Trace Model
1O Timing Configuration device
Voltage

X Auto -
Pin Placement

Error Detection CRC
CwP Settings
Partial Reconfiguration

Use configuration device:
Device Options ...

Configuration device 'O voltage: -
|:| Force WCCIO to be compatible with configuration VO voltage
VID Operation mode -

Configuration pin: Configuration Pin Options. ..

Generate compressed bitstreams I

Active serial clock source: -

Enable input tri-state on active configuration ping in uzer mode

Description:

Specifies the configuration mode used with the configuration scheme for configuring the device.

Figure 6-12 Set Dual Configuration Mode

3. Choose OK to return to the Quartus window. In the Processing menu, choose Start
Compilation or click the Play button on the toolbar to compile the project, generate the
new .sof file.

4. Use the same flow to add the Dual Configuration IP into other project to generate the new .sof
file by internal configuration mode.
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Finally, So far, we have successfully obtained two image .sof files for dual boot demo according
previous steps. this section describes how to generate .pof from .sof files with the internal
configuration mode and program the .pof into configuration flash memory (CFM) through the
JTAG interface.

l. Convert .SOF File to .POF File

1. Choose Convert Programming Files from the File menu of Quartus Il to open new window, as
shown in Figure 6-13.

r M
{_# Quartus Prime Standard Edition - D:/system_cd/Demenstrations/Dual_boot/LedBreathe/DEL0 LITE LedBreathe - DEL0 LITE LedBreathe lilﬂlﬂ
Edit View Project Assignments Processing Tools Window Help Search altera.com e

[ new. CtrsN E_Ledbreae v & A P EESSAED @ )
[ Open... Ctrl+0
- =[[a = | ¢ de10_lite_ledbreathe. v x| | ‘IP Catalog @& =
Close Ciri+F4 — =
B 8 =E mprm 0w Y E S o X =
New Project Wizard... 1 .
- 2 = 4 gk instaled P
. | Open Project (e 3 // This code is generated by Terasic system Builder 4 Project Directory
Save Project 4 I =
5 b > System
Closg Project g Emodule DELO_LITE_LedBreathe( ] 4 Library
Save Cirl+5 B | L CLock /77000 » Basic Functions
- ] input ADC_CLK_10, . Dep
Save As... 10 input MaxX10_CLK1_50,
11 input MAX10_CLK2_50, : Interface Protocols
W Save Al Cirl+Shift+5 12
13 > Memory Interfaces and Controllers
Eile Properties... 14 H > Processors and Peripherals
15 ouTputT [1:0] DRAM_BA,
T , 16 output DRAM_CAS_N, » University Program
reate ate e
b b 17 output e Search for Partner IP
Export.. 18 output
- L 19 output
Convert Programming Files... I =@ = 20 inout
- 21 output
@ Page Setup.. L 22 output
|=| 23 output
Print Preview —|| 24 output
25
= Print.. CirP 36
27 output
Recent Files 3 28 output
I filess 7| 20 nutnut S
3 < [t 3 + Add...
Recent Projects. 3
Exit AleF4 A Find lext
@ Type ID Message
o
@
(I »
i
éﬂ System Processing
0% 00:00:00
L

Figure 6-13 Select Convert Programming Files and click

no

Select Programmer Object File (.pof) from the Programming file type field in the dialog of
Convert Programming Files.

Choose Internal Configuration from the Mode filed.

Browse to the target directory from the File name field and specify the name of output file.
Click on the SOF data in the section of Input files to convert, as shown in Figure 6-14.

ok w
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- - B
@ Convert Programming Fil-MWDULEdB reathe/DE10_LITE_LedBreathe - DE10_LIT... E‘@g

File Tools Window

Search altera.com .

Specify the input files to convert and the type of programming file to generate.
“ou can also import input file information from other files and save the conversion setup information created here for
future use.

Conversion setup fies

Open Conversion Setup Data... ] [ Save Conversion Setup... ]

Output programming file

Programming file type: I Programmer Object File (.pof} -
[ Internal Configuration - ]

Options/Boot info... | Configuration device: EPCE16 * | Mode:

File name: dual_boot.pof

Advanced... Remote/Local update difference file: NOMNE -

Create Memory Map File (Generate dual_boot.map)

Create CvP files (Generate dual_boot.periph.pof and dual_boot.core.rbf)

|:| Create config data RPD (Generate dual_boot_auto.rpd)

Input files to convert

File/Data area Properties Start Address Add Hex Data
|ISOF Data Page_0 =auto= |

Add Sof Page

Add Eile...

Remove

Up

Down

Properties

Generate ] [ Close ] l Help

Figure 6-14 Dialog of Convert Programming Files and setting

6. Click Add File and select the DE10_LITE_LedBreathe.sof of LedBreathe demo to be the sof
data of Page_0.

7. Click Add Sof Page to add Page 1 and click Add File, Select the DE10_LITE_GSensor.sof of
GSensor demo to be the .sof data of Page_1 as shown in Figure 6-15.

8. Click Generate.

These project files can be found in the CD directorie \Demonstrations\Dual _boot\
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F ™
ﬁ Convert Programming File - D:/system_cd/Demonstrations/Dual_boot/LedBreathe/DE10_LITE LedBreathe - DE10_LIT... E‘ﬂg

File Tools Window Search atera.com B

Specify the input files to convert and the type of programming file to generate.
ou can alzo import input file infermation from other files and save the conversion setup information created here for
future use.

Conversion setup files

[ Open Conversion Setup Data... ] [ Save Conversion Setup... ]

Output programming file

I Programming file type: [Prngramrner Object File (.pof) - ]
Options/Boot info... | Cenfiguration device: EPCE16 Mode: Internal Configuration b ]
File name: dual_boot.pof B

RemotelLocal update difference file: NONE

Create Memory Map File (Generate dual_boot. map)
Create CvP files (Generate dual boot.periph.pof and dual_boot.core.rbf)

|:| Create config data RPD (Generate dual_boot_aute.rpd)

Input files to convert

File/Data area Properties Start Address Add Hex Data
4 SOF Dat P 0 t
ata age_ <auto= Add Sof Page
DE10_LME_LedBreathe.sof 10MS0DAF424
4 SOF Data Page_1 <guto= Add File...
DE10_LME_GSensor.sof 10MS0DAF484
Remove
Up
Down
I Properties
I Generate ] [ Close l [ Help

Figure 6-15 Add sof page and sof file

1. Write POF File into the CFM Device

When the conversion of SOF-to-POF file is complete, please follow the steps below to program the
MAX 10 device with the .pof file created in Quartus Il Programmer.

Choose Programmer from the Tools menu and the Chain.cdf window will appear.

Click Hardware Setup and then select the USB-Blaster as shown in Figure 6-16.

Click Add File and then select the dual_boot.pof.

Program the CFM device by clicking the corresponding Program/Configure and Verify box,
as shown in Figure 6-17.

5. Click Start to program the CFM device.

el
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Now, you can set the BOOT_SEL by JP5, you will find if you open JP5 (BOOT_SEL = 0), the Led
Breathe functions would show. Power down the board, insert the jumper to JP5 (BOOT_SEL = 1),
then Power on, you would find the Gsensor functions show.

Hardware Settings | JTAG Settings. |

T R =

Select a programming hardware setup to use when programming devices. This programming
hardware getup applies cnly to the current programmer window.

Currently selected hardware: [USEI-EIﬂster [usB-0]

7

Available hardware items

Hardware
USB-Blaster

Server
Local

Part
USB-0

Add Hardware...

|F‘.emuve Hardwarel

Figure 6-16 Hardware setup window

& Programmer - DJs_ysTem_chEmon5trﬂﬁon;,.'Bual_mutﬂ_eﬁBmaﬂwefDElﬂ_mE_LedBreaﬂ'le - DE10_LITE LedBreathe ... Eléu

File Edit \iew Processing Toole Window  Help Search atera.com .
2, Hardware Setup .| USB-Blaster [USB-1] Mode: [ITAG ~|  FProgress: [ ]
nal reak-tme 0 aliow Dackground programming wWnen aval
[¥] Enable reak-time ISP to allow background ing wh ilable
0 File Device Checksum Usercode Program/ Blank- Examine
U Start Configure Check
|7.qu Stop | dual_boot.pof 10MS0DAF484 DEDBA41S 00281B1F ]
CFMD O
M Auto Detect CFM1 |
UFM O

3 Delste

¥ Change File...

r* Add Device...

E
&
:

ml Save File

1 up

1% Down

1

www.terasic.com

Figure 6-17 Programmer window with dual_boot.pof file
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Additional Information

Getting Help

Here are the addresses where you can get help if you encounter problems:
Terasic Inc.

9F.,, N0.176, Sec.2, Gongdao 5th Rd, East Dist, Hsinchu City, 30070. Taiwan
Email: support@terasic.com

Web: www.terasic.com

DE10-Lite Web: http://del10-lite.terasic.com/

Revision History

2016.06 V1.0 Initial Version (Preliminary)

2016.09 V1.1 Minor corrections: fixing typos and change MAX 10 to production version.
2016.10 V1.2 Minor corrections: fixing typos and add chapter 6.

2016.11 V1.3 Modify control panel memory dialog. Change 16-bit word to 8-bit word.
2016.11 V14 Modify section 3.3 for rev.B hardware and push-button block diagram.
2018.5 V1.5 Modify section 3.4 for 7-segment displays description

Modify Microsoft Windows XP to Win 7/Win 10 64-bit version in Page 3, and add

2018.10 V1.6 ) ,
step 3 in section 2.1 Control Panel Setup.

Copyright Statement

Copyright © 2017 Terasic Inc. All rights reserved.
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Mouser Electronics

Authorized Distributor

Click to View Pricing, Inventory, Delivery & Lifecycle Information:

Terasic:
P0466 P0466-EDU



https://www.mouser.com/terasic-technologies
https://www.mouser.com/access/?pn=P0466
https://www.mouser.com/access/?pn=P0466-EDU
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